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MSG revision history

Revision Publication date Description

A October 2009 The fingerprint reader board cable is included in the Cable Kit, spare part number
451722-001. The information was updated in the following locations: Illustrated
parts catalog on page 18, Cable Kit on page 26, Sequential part number listing
on page 29, and Top cover on page 67.

The modem cable, LED cable, and capacity board cable are included in the Cable
Kit, spare part number 451722-001. The information was updated in the following
location: Cable Kit on page 26.

B February 2011 The Intel Core Duo U7700 1.33-GHz processor with 533-MHz FSB and 2-MB L2
cache was added in the following location: Product description on page 1. The
system board with the Intel Core Duo U7700 1.33-GHz processor, spare part
number 464764-001, was added in the following locations: Computer major
components on page 19, Sequential part number listing on page 29, and System
board on page 70.
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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).

v



vi   Safety warning notice



Table of contents

1  Product description ........................................................................................................................................ 1

2  External component identification ................................................................................................................ 5
Display components ............................................................................................................................. 5
Top components ................................................................................................................................... 6

Buttons and fingerprint reader ............................................................................................. 6
Keys ..................................................................................................................................... 7
Lights ................................................................................................................................... 8
Pointing devices ................................................................................................................. 10

Front components .............................................................................................................................. 11
Left-side components ......................................................................................................................... 12
Rear components ............................................................................................................................... 13
Right-side components ....................................................................................................................... 14
Bottom components ........................................................................................................................... 16

3  Illustrated parts catalog ............................................................................................................................... 18
Serial number location ........................................................................................................................ 18
Computer major components ............................................................................................................. 19
Plastics Kit .......................................................................................................................................... 25
Cable Kit ............................................................................................................................................. 26
Mass storage devices ......................................................................................................................... 27
Miscellaneous parts ............................................................................................................................ 27
Sequential part number listing ............................................................................................................ 29

4  Removal and replacement procedures ....................................................................................................... 34
Preliminary replacement requirements ............................................................................................... 34

Tools required .................................................................................................................... 34
Service considerations ....................................................................................................... 34

Plastic parts ....................................................................................................... 34
Cables and connectors ..................................................................................... 35
Drive handling ................................................................................................... 35

Grounding guidelines ......................................................................................................... 36
Electrostatic discharge damage ........................................................................ 36

vii



Packaging and transporting guidelines ............................................. 37
Workstation guidelines ..................................................................... 37
Equipment guidelines ....................................................................... 38

Unknown user password ................................................................................................... 39
Component replacement procedures ................................................................................................. 40

Serial number .................................................................................................................... 40
Computer feet .................................................................................................................... 40
Battery ............................................................................................................................... 41
SIM .................................................................................................................................... 42
Bluetooth module ............................................................................................................... 43
Memory module ................................................................................................................. 45
RTC battery ....................................................................................................................... 47
WLAN module .................................................................................................................... 48
Hard drive .......................................................................................................................... 52
WWAN module .................................................................................................................. 54
Optical drive ....................................................................................................................... 56
Switch cover ...................................................................................................................... 57
Keyboard ........................................................................................................................... 59
Display assembly ............................................................................................................... 62
Top cover ........................................................................................................................... 67
System board ..................................................................................................................... 70
Speaker assembly ............................................................................................................. 73
Fan/heat sink assembly ..................................................................................................... 74
PC Card assembly ............................................................................................................. 76
Modem module .................................................................................................................. 78

5  Computer Setup ............................................................................................................................................ 80
Starting Computer Setup .................................................................................................................... 80
Using Computer Setup ....................................................................................................................... 81

Navigating and selecting in Computer Setup ..................................................................... 81
Restoring factory settings in Computer Setup ................................................................... 81

Computer Setup menus ..................................................................................................................... 82
File menu ........................................................................................................................... 82
Security menu .................................................................................................................... 83
Diagnostics menu .............................................................................................................. 83
System Configuration menu .............................................................................................. 84

6  Specifications ................................................................................................................................................ 86
Computer specifications ..................................................................................................................... 86
12.1-inch, WXGA display specifications ............................................................................................. 87
Hard drive specifications .................................................................................................................... 88
DVD±RW and CD-RW Double-Layer Combo Drive specifications .................................................... 89
DVD/CD-RW Combo Drive specifications .......................................................................................... 90

viii



DVD-ROM Drive ................................................................................................................................. 91
System DMA specifications ................................................................................................................ 92
System interrupt specifications ........................................................................................................... 93
System I/O address specifications ..................................................................................................... 94
System memory map specifications ................................................................................................... 96

7  Screw listing .................................................................................................................................................. 97
Phillips PM2.0×5.0 captive screw ....................................................................................................... 98
Phillips PM2.0×5.0 screw ................................................................................................................. 100
Phillips PM2.5×4.0 screw ................................................................................................................. 101
Torx T8M2.5×7.0 screw ................................................................................................................... 103
Torx T8M2.5×4.0 screw ................................................................................................................... 106
Phillips PM2.0×3.0 screw ................................................................................................................. 108
Phillips PM1.5×3.0 screw ................................................................................................................. 109
Torx T6M2.0×5.0 screw ................................................................................................................... 110
Phillips PM2.0×4.0 screw ................................................................................................................. 111
Phillips PM2.0×2.0 broad-head screw .............................................................................................. 112
Phillips PM2.0×10.0 screw ............................................................................................................... 113

8  Backup and recovery .................................................................................................................................. 114
Backup and recovery using Windows Vista ..................................................................................... 114

Creating recovery discs ................................................................................................... 114
Backing up your information ............................................................................................ 114

When to back up ............................................................................................. 115
Backup suggestions ........................................................................................ 115
Backing up specific files or folders .................................................................. 115
Backing up the entire hard drive ..................................................................... 116
Creating recovery points ................................................................................. 117
Scheduling backups ........................................................................................ 117

Performing a recovery ..................................................................................................... 117
Performing a recovery from the recovery discs ............................................... 118
Performing a recovery from the hard drive ...................................................... 118

Initiating a recovery in Windows ..................................................... 119
Initiating a recovery from the hard drive recovery partition ............. 119

Backup and recovery using Windows XP ......................................................................................... 120
Creating recovery discs ................................................................................................... 120
Backing up your information ............................................................................................ 120

When to back up ............................................................................................. 121
Backup suggestions ........................................................................................ 121
Backing up specific files or folders .................................................................. 121
Backing up the entire hard drive ..................................................................... 122
Creating recovery points ................................................................................. 123
Scheduling backups ........................................................................................ 123

ix



Performing a recovery ..................................................................................................... 123
Performing a recovery from the recovery discs ............................................... 124
Performing a recovery from the hard drive ...................................................... 124

Initiating a recovery in Windows ..................................................... 125
Initiating a recovery from the hard drive recovery partition ............. 125

9  Connector pin assignments ....................................................................................................................... 126
Audio-out (headphone) ..................................................................................................................... 126
Audio-in (microphone) ...................................................................................................................... 126
External monitor ............................................................................................................................... 127
RJ-11 (modem) ................................................................................................................................ 128
RJ-45 (network) ................................................................................................................................ 128
Universal Serial Bus ......................................................................................................................... 129

10  Power cord set requirements .................................................................................................................. 130
Requirements for all countries and regions ...................................................................................... 130
Requirements for specific countries and regions ............................................................................. 131

11  Recycling ................................................................................................................................................... 132
Battery .............................................................................................................................................. 132
Display .............................................................................................................................................. 132

Index ................................................................................................................................................................. 138

x



1 Product description

Category Description

Branding ● Long name: HP Compaq 2510p Notebook PC

● Short name: HP Compaq 2510p

● Logo badge: Compaq 2510p

Processors Intel® Core™ Duo processors:

● U7700 1.33-GHz processor with 533-MHz Front Side Bus (FSB) and 2-MB L2 cache

● U7600 1.20-GHz processor with 533-MHz FSB and 2-MB L2 cache

● U7500 1.06-GHz processor with 533-MHz FSB and 2-MB L2 cache

Chipsets ● Northbridge: Intel Crestline GM

 ● Southbridge: Intel ICH8-M enhanced

Graphics Intel Crestline Graphics, Unified Memory Architecture (UMA), integrated with shared video memory,
up to 384-MB shared memory

Panels ● 12.1 WXGA (1280 × 800), configured with 3 WLAN antennas and 2 WWAN antennas

● Supports privacy filter

Memory ● One SODIMM slot, customer accessible/upgradable

● PC2-5300, 667-MHz, DDRII

● Supports single-channel memory

● Supported configurations:

◦ 4096-MB total system memory (4096 MB × 1)

◦ 2048-MB total system memory (2048 × 1)

◦ 1024-MB total system memory (1024 MB × 1)

◦ 512-MB total system memory (512 MB × 1)
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Category Description

Hard drives ● Supports all 1.8-inch hard drives

● Parallel ATA

● The following hard drives are available:

◦ 100-GB, 4200-rpm

◦ 80-GB, 4200-rpm

◦ 60-GB, 4200-rpm

Optical drives ● 9.5-mm tray load

● Parallel ATA

● Removable with two screws

● Supports the following optical formats:

◦ DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

◦ DVD/CD-RW Combo Drive

◦ DVD-ROM Drive

● Supports no-optical-drive option with blank bezel

Diskette drive Supports an external Universal Serial Bus (USB) diskette drive only

Audio ● Azalia ADI1981HD

● Single speaker

● Integrated monoaural microphone

● Headphone and microphone jacks

Modem ● 56K, v.92, data/fax modem (MDC1.5)

● Modem cable included in Brazil, the Czech Republic, France, Greece, Hungary, Israel, Latin
America, Poland, Russia, Saudi Arabia, Slovakia, Slovenia, South Africa, Turkey, and the
United Kingdom.

Ethernet ● Intel 10/100/1000 Ethernet

● Network interface card (NIC) power-down

● S4/S5 wake on LAN (on AC power only)

Wireless Integrated wireless options by way of wireless module
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Category Description

 Wireless local area network (WLAN) options:

● Broadcom 802.11a/b/g

● Broadcom 802.11b/g

● Intel 802.11a/b/g/n with iAMT support

● Intel 802.11a/b/g with iAMT support

● Intel 802.11b/g

● Three 2.4-/5.0-GHzWLAN antennas built into display panel

● Supports no-WLAN option

 Wireless wide area network (WWAN) options:

● Evolution-data optimized (EVDO-A) WWAN module

● High-speed downlink packet access (HSPDA) WWAN module

● Subscriber identity module (SIM)

● Two 5-band antennas built into display panel

 Wireless personal area network (WPAN) options:

● Bluetooth® module

● Supports no-WPAN option

External media
card

● One Type I/II PC Card slot

● 16-bit PCMCIA and 32-bit CardBus

● Integrated SD flash media slot (SD/MMC support)

Ports ● 1394a port

● Docking connector

● Headphone connector

● Microphone connector

● Primary battery connector

● RJ-11 modem port

● RJ-45 Ethernet port

● Smart AC adapter connector

● USB ports (2)

● VGA port (Dsub 15-pin) supporting 1600 × 1200 external resolution @ 75 Hz, hot plug/unplug,
and auto detect

Docking Docking support
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Category Description

Keyboard/pointing
devices

● Spill-resistant keyboard with embedded numeric keypad, TouchPad, pointing stick, and
fingerprint reader

● Full-size, 19.05-mm pitch, 4.5-mm height keyboard

● One-way scrolling (vertical)

● Windows Vista™ hardware Start button

● Durable key caps

Power
requirements

Primary batteries:

● 9-cell, 83-Wh, Li-ion battery with fuel gauge

● 6-cell, 55-Wh, Li-ion battery with fuel gauge

● 3-cell, 28-Wh Li-ion battery

● 65-watt AC adapter with localized cable plug support and 3-wire plug

Security ● Support for Kensington security lock

● Optional integrated active smart card reader (installed in the PC Card slot)

● Integrated Infineon TPM 1.2 chip (soldered to PCB)

● Integrated USB-based fingerprint reader

Operating
system

Preinstalled:

● Windows Vista Home Basic (32-bit)

● Windows Vista Business (32- and 64-bit)

● Windows® XP Professional

● FreeDOS

Certified: Linux

Serviceability End-user replaceable parts:

● AC adapter

● Battery

● Bluetooth module

● Hard drive

● Memory module

● Optical drive

● Power cord

● RTC battery

● SIM

● WLAN module

● WWAN module
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2 External component identification

Display components

Item Component Function

(1) Display release latch Opens the computer.

(2) Internal display switch Turns off the display if the display is closed while the
computer is on.

(3) Internal microphone Records sound.

(4) Ambient light sensor When activated, the sensor automatically adjusts the
display brightness based on the surrounding lighting
conditions.
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Top components
Buttons and fingerprint reader

Item Component Function

(1) Power button ● When the computer is off, press the button to turn
on the computer.

● When the computer is on, press the button to shut
down the computer.

● When the computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP), press the button
briefly to exit the Sleep state or Standby.

● When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the
computer.

To learn more about power settings, follow these steps:

● In Windows Vista, select Start > Control Panel >
System and Maintenance > Power Options.

● In Windows XP, select Start > Control Panel >
Performance and Maintenance > Power Options.

(2) Info button Launches Info Center, which enables you to open various
software solutions.

(3) Wireless button Turns the wireless feature on or off, but does not
establish a wireless connection.

NOTE: A wireless network must be set up in order to
establish a wireless connection.

(4) Presentation button Starts the presentation feature.
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Item Component Function

(5) TouchPad on/off button Turns the TouchPad on and off.

(6) Volume mute button (select models only) Mutes and restores speaker sound.

(7) Volume scroll zone Adjusts speaker volume. Slide your finger to the left to
decrease volume and to the right to increase volume.

(8) HP Fingerprint Sensor Allows a fingerprint logon to Windows, instead of a
password logon.

Keys
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Function

(1) esc key Displays system information when pressed in
combination with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric
keypad.

(6) Function keys Execute frequently used system functions when pressed
in combination with the fn key.
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Lights

Item Component Function

(1) Wireless lights (2)* ● On: An integrated wireless device, such as a
wireless local area network (WLAN) device, the HP
Broadband Wireless Module, and/or a Bluetooth®
device, is on.

● Off: All wireless devices are off.

(2) Power lights (2)† ● On: The computer is on.

● Blinking: The computer is in Standby.

● Blinking rapidly: An AC adapter with a higher power
rating should be connected.

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the
battery light begins blinking rapidly.

● Off: If the computer is plugged into an external
power source, the light turns off when all batteries in
the computer are fully charged. If the computer is
not plugged into an external power source, the light
stays off until the battery reaches a low battery level.

(4) Drive light ● Blinking green: The hard drive or optical drive is
being accessed.

● Amber: HP 3D DriveGuard has temporarily parked
the internal hard drive.

(5) Caps lock light On: Caps lock is on.
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Item Component Function

(6) Num lock light On: Num lock is on or the embedded numeric keypad is
enabled.

(7) Volume mute light ● Off: Computer sound is on.

● On: Computer sound is off.

(8) Volume down light On: The volume scroll zone is being used to decrease
speaker volume.

(9) Volume up light On: The volume scroll zone is being used to increase
speaker volume.

*The 2 wireless lights display the same information. The light on the wireless button is visible only when the computer is
open. The wireless light on the front of the computer is visible whether the computer is open or closed.

†The 2 power lights display the same information. The light on the power button is visible only when the computer is open.
The power light on the front of the computer is visible whether the computer is open or closed.
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Pointing devices

Item Component Function

(1) TouchPad on/off button Turns the TouchPad on and off.

(2) Pointing stick Moves the pointer and selects or activates items on the
screen.

(3) Left pointing stick button* Functions like the left button on an external mouse.

(4) TouchPad* Moves the pointer and selects or activates items on the
screen.

(5) Left TouchPad button* Functions like the left button on an external mouse.

(6) Right TouchPad button* Functions like the right button on an external mouse.

(7) TouchPad scroll zone Scrolls up or down.

(8) Right pointing stick button* Functions like the right button on an external mouse.

*This table describes factory settings. View or change pointing device preferences as follows:

● In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.
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Front components

Item Component Function

(1) Wireless light ● On: An integrated wireless device, such as a WLAN
device, the HP Broadband Wireless Module, and/or
a Bluetooth device, is turned on.

● Off: All wireless devices are turned off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state
(Windows Vista) or in Standby (Windows XP).

● Blinking rapidly: An AC adapter with a higher power
rating should be connected.

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the
battery light begins blinking rapidly.

● Off: If the computer is plugged into an external
power source, the light turns off when all batteries in
the computer are fully charged. If the computer is
not plugged into an external power source, the light
stays off until the battery reaches a low battery level.

(4) Drive light ● Blinking green: The hard drive or optical drive is
being accessed.

● Amber (select models only): HP 3D DriveGuard has
temporarily parked the hard drive.

(5) Bluetooth module (select models only) Sends and receives Bluetooth device signals.

WARNING! Exposure to Radio Frequency Radiation.
The radiated output power of this device is below the
FCC radio frequency exposure limits. Nevertheless, the
device should be used in such a manner that the potential
for human contact during normal operation is minimized.
To avoid the possibility of exceeding the FCC radio
frequency exposure limits, human proximity to the
antennae should be not less than 20 cm (8 inches) during
normal operation, including when the computer display is
closed.

(6) Display release latch Opens the computer.
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Left-side components

Item Component Function

(1) Power connector Connects an AC adapter.

(2) RJ-11 (modem) jack Connects a modem cable.

(3) USB port Depending on your computer model, the USB port is
either a standard USB port or a powered USB port. A
standard USB port connects an optional USB device. A
powered USB port provides power to an external device if
used with a powered USB cable.

(4) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(5) Optical drive (select models only) Reads an optical disc.

(6) Optical drive light Blinking: The optical drive is being accessed.
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Rear components

Item Component Function

(1) RJ-45 (network) jack Connects a network cable.

(2) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.
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Right-side components
NOTE: Computer features vary depending on model. Refer to one of the following illustrations.

Item Component Function

(1) PC Card slot (select models only) Supports optional Type I or Type II PC Cards.

(2) Media Card Reader Supports the following optional digital card formats:
Secure Digital (SD) Memory Card, MultiMediaCard
(MMC).

(3) 1394a port Connects an optional IEEE 1394 or 1394a device, such
as a camcorder.

(4) Audio-out (headphone) jack Produces computer sound when connected to optional
powered stereo speakers, headphones, ear buds, a
headset, or television audio.

(5) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(6) USB port Connects an optional USB device.

(7) External monitor port Connects an external VGA monitor or projector.

(8) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(9) Docking connector Connects an optional docking device.

Item Component Function

(1) Smart card reader (select models only) Supports smart cards and Java™ Cards.

(2) Media Card Reader Supports the following optional digital card formats:
Secure Digital (SD) Memory Card, MultiMediaCard
(MMC).

(3) 1394a port Connects an optional IEEE 1394 or 1394a device, such
as a camcorder.
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Item Component Function

(4) Audio-out (headphone) jack Produces computer sound when connected to optional
powered stereo speakers, headphones, ear buds, a
headset, or television audio.

(5) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(6) USB port Connects an optional USB device.

(7) External monitor port Connects an external VGA monitor or projector.

(8) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(9) Docking connector Connects an optional docking device.
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Bottom components

Item Component Function

(1) Speaker Produces computer sound.

(2) Memory module/WLAN module compartment Contains a memory module slot and a WLAN module
slot.

CAUTION: To prevent an unresponsive system,
replace the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.

(3) Hard drive bay Holds the hard drive.

(4) Vents (6) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(5) Battery release latches (2) Release the battery from the battery bay.

(6) Battery bay Holds the battery.

(7) SIM slot Contains a subscriber identity module (SIM). The SIM
slot is located inside the battery bay.
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Item Component Function

(8) WWAN module compartment Contains a WWAN module slot.

CAUTION: To prevent an unresponsive system,
replace the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.

(9) Business-card holder Holds a standard-sized business card.

(10) Bluetooth module compartment (select models only) Contains a Bluetooth device.
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3 Illustrated parts catalog

Serial number location
When ordering parts or requesting information, provide the computer serial number and model
number located on the bottom of the computer.
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Computer major components

Item Description Spare part number

(1) 12.1-inch, WXGA display assembly with AntiGlare (includes wireless antenna
transceivers and cables, and microphone and cable)

451741-001

 Display internal components:

 Display bezel 451733-001

 Display panel cable 451735-001
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Item Description Spare part number

 Display enclosure (includes WLAN and WWAN antenna transceivers and cables) 451736-001

 Display hinges 451734-001

 Display lid switch module 451724-001

 Display Screw Kit 451737-001

(2) Switch cover (includes LED board and cable) 451717-001

(3) Keyboards (include pointing stick and pointing stick cable)

 Belgium 451748-A41

 Brazil 451748-201

 The Czech Republic 451748-221

 Denmark 451748-081

 France 451748-051

 French Canada 451748-121

 Germany 451748-041

 Greece 451748-151

 Hungary 451748-211

 Iceland 451748-DD1

 The Netherlands and Europe 451748-021

 Israel 451748-BB1

 Italy 451748-061

 Japan 451748-291

 Latin America 451748-161

 Norway 451748-091

 Portugal 451748-131

 Russia 451748-251

 Saudi Arabia 451748-171

 Slovakia 451748-231

 Slovenia 451748-BA1

 South Korea 451748-AD1

 Spain 451748-071

 Sweden and Finland 451748-B71

 Switzerland 451748-111

 Taiwan 451748-AB1

 Thailand 451748-281

 Turkey 451748-141
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Item Description Spare part number

 The United Kingdom 451748-031

 The United States 451748-001

(4) Top cover (includes TouchPad and fingerprint reader board)

NOTE: The fingerprint reader board cable is included in the Cable Kit, spare part number
451722-001.

451723-001

(5) PC Card assembly 451742-001

 Plastics Kit (see Plastics Kit on page 25 for more Plastics Kit spare part information): 451743-001

(6a) PC Card slot bezel

(6b) Memory module/WLAN module compartment cover

(6c) Bluetooth module compartment cover

(6d) Hard drive cover

(6e) WWAN module compartment cover

(7) System boards (include thermal material and alcohol pad)

 Equipped with Intel Core Duo U7700 (1.33-GHz) processor (533-MHz FSB and 2-MB L2
cache)

464764-001

 Equipped with Intel Core Duo U7600 (1.20-GHz) processor (533-MHz FSB and 2-MB L2
cache)

451720-001

 Equipped with Intel Core Duo U7500 (1.06-GHz) processor (533-MHz FSB and 2-MB L2
cache)

451719-001

(8) Speaker assembly 451747-001

(9) Modem modules (include modem module cable)

 For use in all countries and regions except Australia and New Zealand 443899-001

 For use only in Australia and New Zealand 443899-011

(10) Optical drives (include bezel)

 DVD±RW and CD-RW Double-Layer Combo Drive 451727-001

 DVD/CD-RW Combo Drive 451725-001

 DVD-ROM Drive 451726-001

(11) Fan/heat sink assembly (includes thermal material) 451731-001

(12) Base enclosure (includes front LED board, front LED board cable, and rubber feet) 451712-001

 Rubber Kit (not illustrated; includes 5 rubber feet and 2 base enclosure screw
covers)

451744-001

(13) Batteries

 9-cell, 83-Wh Li-ion 451715-001

 6-cell, 55-Wh Li-ion 451714-001

 3-cell, 28-Wh Li-ion 451713-001

(14) WLAN modules
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Item Description Spare part number

 802.11a/b/g/n Broadcom WLAN modules:

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

441530-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belgium, Belize, Benin, Bermuda, Bolivia, Bosnia &
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina
Faso, Burundi, Cameroon, Cape Verde, the Cayman Islands, the Central African
Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French Guiana, Gabon, Gambia Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory
Coast, Jamaica, Jordan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, the Maldives,
Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of
China, Peru, the Philippines, Poland, Portugal, Puerto Rico, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia,
Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts &
Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, the United Arab Emirates, the United Kingdom,
Uruguay, Uzbekistan, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441530-002

 ● For use in Japan 441530-291

 802.11a/b/g/n Intel WLAN modules:

 ● For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong,
India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan,
Uruguay, the United States, Venezuela, and Vietnam

441086-001

 ● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the
Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany,
Greece, Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein,
Lithuania, Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the
Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and Montenegro,
Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland,
Turkey, Ukraine, the United Kingdom, and Uzbekistan

441086-002

 ● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and
South Korea

441086-003

 ● For use in Japan 441086-291

 802.11a/b/g Broadcom WLAN modules:

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

441075-001
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Item Description Spare part number

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua
New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South
Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent &
Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-002

 ● For use in Japan 441075-291

 802.11a/b/g Intel WLAN modules:

 ● For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong,
India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan,
the United States, Uruguay, Venezuela, and Vietnam

441082-001

 ● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the
Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany,
Greece, Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein,
Lithuania, Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the
Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and Montenegro,
Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland,
Turkey, Ukraine, the United Kingdom, and Uzbekistan

441082-002

 ● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and
South Korea

441082-003

 ● For use in Japan 441082-291

 802.11b/g Broadcom WLAN modules:

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

441090-001
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Item Description Spare part number

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia & Herzegovina Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African
Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan,
Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall
Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau,
Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru, the
Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia
and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts &
Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

441090-002

 ● For use in Japan 441090-291

 802.11b/g Intel WLAN module for use in Thailand 448675-004

(15) RTC battery 451716-001

(16) Memory modules (667-MHz, PC2-5300, 1-DIMM)

 2048-MB 451739-001

 1024-MB 451738-001

 512-MB 451740-001

(17) Bluetooth module (includes Bluetooth module cable) 451721-001

(18) Hard drives (include hard drive bracket and connector)

 100-GB, 4200-rpm 453504-001

 80-GB, 4200-rpm 451730-001

 60-GB, 4200-rpm 451729-001

(19) WWAN modules

 Verizon EVDO-A WWAN module 451131-001

 Cingular HSPDA WWAN module 448673-002

 Vodafone HSPDA WWAN module 448672-002

 Cable Kit (not illustrated; see Cable Kit on page 26 for more Cable Kit spare part number
information)

451722-001

 Smart card reader module (not illustrated) 451746-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit: 451743-001

(1) Bluetooth module compartment cover (includes 1 captive screw, secured by a C-clip)

(2) Hard drive cover (includes 2 captive screws, secured by C-clips)

(3) Memory module/WLAN module compartment cover (includes 2 captive screws, secured by C-clips)

(4) WWAN module compartment cover (includes 1 captive screw, secured by a C-clip)

(5) PC Card slot bezel
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Cable Kit
Item Description Spare part number

 Cable Kit: 451722-001

(1) Bluetooth module cable

(2) Fingerprint reader board cable

(3) Modem cable

(4) LED cable

(5) Capacity board cable

26 Chapter 3   Illustrated parts catalog



Mass storage devices

Item Description Spare part number

(1) Optical drives (include bezel)

 DVD±RW and CD-RW Double-Layer Combo Drive 451727-001

 DVD/CD-RW Combo Drive 451725-001

 DVD-ROM Drive 451726-001

(2) Hard drives (include isolator and connector cable)

 100-GB, 4200-rpm 453504-001

 80-GB, 4200-rpm 451730-001

 60-GB, 4200-rpm 451729-001

Miscellaneous parts
Description Spare part number

65-watt AC adapter (HP Smart Adapter) 412786-001

HP 2400 Ultra-Light Docking Station 412787-001

HP 2500 Ultra-Light Docking Station 455157-001

External MultiBay II 366143-001

External MultiBay II power cable and stand 366144-001

HP Extended Life Battery 367456-001

Label Kit 451732-001

MultiBay 8X DVD-ROM Drive 373314-001

MultiBay 24X DVD/CD-RW Combo Drive 373315-001
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Description Spare part number

Nylon carrying case 325814-001

USB 1.1 diskette drive 359118-001

Power cords:

For use in Argentina 394279-D01

For use in Australia 394279-011

For use in Brazil 394279-201

For use in Denmark 394279-081

For use in Europe, the Middle East, and Africa 394279-021

For use in Israel 394279-BB1

For use in India 394279-D61

For use in Italy 394279-061

For use in Japan 394279-291

For use in the People's Republic of China 394279-AA1

For use in South Korea 394279-AD1

For use in Switzerland 394279-111

For use in Taiwan 394279-AB1

For use in the United Kingdom 394279-031

For use the United States 394279-001

Screw Kit

● Phillips PM2.5×4.0 screw

● Phillips PM2.0×10.0 screw

● Phillips PM2.0×5.0 captive screw

● Phillips PM2.0×5.0 screw

● Phillips PM2.0×4.0 screw

● Phillips PM2.0×3.0 screw

● Phillips PM2.0×2.0 broad-head screw

● Phillips PM2.0×2.0 screw

● Phillips PM1.5×3.0 screw

● Torx T8M2.5×7.0 screw

● Torx T8M2.5×4.0 screw

● Torx T6M2.0×5.0 screw

451745-001

28 Chapter 3   Illustrated parts catalog



Sequential part number listing
Spare part
number

Description

394279-001 3-wire power cord for use in the United States

394279-011 3-wire power cord for use in Australia

394279-021 3-wire power cord for use in Europe

394279-031 3-wire power cord for use in the United Kingdom

394279-061 3-wire power cord for use in Italy

394279-081 3-wire power cord for use in Denmark

394279-111 3-wire power cord for use in Switzerland

394279-201 3-wire power cord for use in Brazil

394279-291 3-wire power cord for use in Japan

394279-AA1 3-wire power cord for use in the People's Republic of China

394279-AB1 3-wire power cord for use in Taiwan

394279-AD1 3-wire power cord for use in South Korea

394279-BB1 3-wire power cord for use in Israel

394279-D01 3-wire power cord for use in Argentina

394279-D61 3-wire power cord for use in India

412786-001 65-watt AC adapter (HP Smart Adapter)

412787-001 HP 2400 Ultra-Light Docking Station

441075-001 802.11a/b/g Broadcom WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S.
Virgin Islands, and the United States

441075-002 802.11a/b/g Broadcom WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua
and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa
Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland,
Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe,
Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St.
Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

441075-291 802.11a/b/g Broadcom WLAN module for use in Japan
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Spare part
number

Description

441082-001 802.11a/b/g Intel WLAN module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic,
Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico,
Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay, Venezuela, and Vietnam

441082-002 802.11a/b/g Intel WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia,
Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden,
Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441082-003 802.11a/b/g Intel WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of
China, and South Korea

441082-291 802.11a/b/g Intel WLAN module for use in Japan

441086-001 802.11a/b/g/n Intel WLAN module for use in Antigua and Barbuda, Argentina, Aruba, the Bahamas,
Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia,
Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States, Venezuela,
and Vietnam

441086-002 802.11a/b/g/n Intel WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia,
Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden,
Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441086-003 802.11a/b/g/n Intel WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of
China, and South Korea

441086-291 802.11a/b/g/n Intel WLAN module for use in Japan

441090-001 802.11b/g Broadcom WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S.
Virgin Islands, and the United States

441090-002 802.11b/g Broadcom WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua &
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape
Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel,
Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama, Papua
New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, the
Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia,
Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St.
Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand,
Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

441090-291 802.11b/g Broadcom WLAN module for use in Japan
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Spare part
number

Description

441530-001 802.11a/b/g/n Broadcom WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the
U.S. Virgin Islands, and the United States

441530-002 802.11a/b/g/n Broadcom WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua
& Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belgium, Belize, Benin, Bermuda, Bolivia, Bosnia & Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Cayman Islands, the
Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon,
Gambia Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea,
Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory Coast,
Jamaica, Jordan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru, the
Philippines, Poland, Portugal, Puerto Rico, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St.
Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

441530-291 802.11a/b/g/n Broadcom WLAN module for use in Japan

443899-001 Modem module for use in all countries and regions except Australia and New Zealand (includes modem
module cable)

443899-011 Modem module for use only in Australia and New Zealand (includes modem module cable)

448672-002 Vodafone HSPDA WWAN module

448673-002 Cingular HSPDA WWAN module

448675-004 802.11b/g Intel WLAN module for use in Thailand

451131-001 Verizon EVDO-A WWAN module

451712-001 Base enclosure (includes front LED board, front LED board cable, and rubber feet)

451713-001 3-cell, 28-Wh Li-ion battery

451714-001 6-cell, 55-Wh Li-ion battery

451715-001 9-cell, 83-Wh Li-ion battery

451716-001 RTC battery

451717-001 Switch cover (includes LED board and cable)

451719-001 System board equipped with Intel Core Duo U7600 (1.20-GHz) processor (533-MHz FSB and 2-MB L2
cache; includes thermal material and alcohol pad)

451720-001 System board equipped with Intel Core Duo U7500 (1.06-GHz) processor (533-MHz FSB and 2-MB L2
cache; includes thermal material and alcohol pad)

451721-001 Bluetooth module (includes Bluetooth module cable)

451722-001 Cable Kit (see Cable Kit on page 26 for more Cable Kit spare part number information)

451723-001 Top cover (includes TouchPad and fingerprint reader board)

NOTE: The fingerprint reader board cable is included in the Cable Kit, spare part number 451722-001.
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number

Description

451724-001 Display lid switch module

451725-001 DVD/CD-RW Combo Drive

451726-001 DVD-ROM Drive

451727-001 DVD±RW and CD-RW Double-Layer Combo Drive

451729-001 60-GB, 4200-rpm hard drive (includes hard drive bracket and connector)

451730-001 80-GB, 4200-rpm hard drive (includes hard drive bracket and connector)

451731-001 Fan/heat sink assembly (includes thermal material)

451732-001 Label Kit

451733-001 Display bezel

451734-001 Display hinges

451735-001 Display panel cable

451736-001 Display enclosure (includes WLAN and WWAN antenna transceivers and cables)

451737-001 Display Screw Kit

451738-001 1024-MB memory module (667-MHz, PC2-5300, 1-DIMM)

451739-001 2048-MB memory module (667-MHz, PC2-5300, 1-DIMM)

451740-001 512-MB memory module (667-MHz, PC2-5300, 1-DIMM)

451741-001 12.1-inch, WXGA display assembly with AntiGlare (includes wireless antenna transceivers and cables and
microphone and cable)

451742-001 PC Card assembly

451743-001 Plastics Kit (see Plastics Kit on page 25 for more Plastics Kit spare part information):

451744-001 Rubber Kit (includes 5 computer feet and 2 base enclosure screw covers)

451745-001 Screw Kit

451746-001 Smart card reader module

451747-001 Speaker assembly

451748-001 Keyboard for use in the United States

451748-021 Keyboard for use in the Netherlands and Europe

451748-031 Keyboard for use in the United Kingdom

451748-041 Keyboard for use in Germany

451748-051 Keyboard for use in France

451748-061 Keyboard for use in Italy

451748-071 Keyboard for use in Spain

451748-081 Keyboard for use in Denmark

451748-091 Keyboard for use in Norway

451748-111 Keyboard for use in Switzerland
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Spare part
number

Description

451748-121 Keyboard for use in French Canada

451748-131 Keyboard for use in Portugal

451748-141 Keyboard for use in Turkey

451748-151 Keyboard for use in Greece

451748-161 Keyboard for use in Latin America

451748-171 Keyboard for use in Saudi Arabia

451748-201 Keyboard for use in Brazil

451748-211 Keyboard for use in Hungary

451748-221 Keyboard for use in the Czech Republic

451748-231 Keyboard for use in Slovakia

451748-251 Keyboard for use in Russia

451748-281 Keyboard for use in Thailand

451748-291 Keyboard for use in Japan

451748-A41 Keyboard for use in Belgium

451748-AB1 Keyboard for use in Taiwan

451748-AD1 Keyboard for use in South Korea

451748-B71 Keyboard for use in Sweden and Finland

451748-BA1 Keyboard for use in Slovenia

451748-BB1 Keyboard for use in Israel

451748-DD1 Keyboard for use in Iceland

453504-001 100-GB, 4200-rpm hard drive (includes hard drive bracket and connector)

455157-001 HP 2500 Ultra-Light Docking Station

464764-001 System board equipped with Intel Core Duo U7700 (1.33-GHz) processor (533-MHz FSB and 2-MB L2
cache; includes thermal material and alcohol pad)
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a
static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Preliminary replacement requirements 35



Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the
password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 47).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 67 screws, in 12 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Serial number
Report the computer serial number to HP when requesting information or ordering spare parts. The
serial number is located on the bottom of the computer.

Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 451744-001. There are 5 rubber feet that attach to the base enclosure in the locations
illustrated below.
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Battery

Description Spare part number

9-cell, 83-Ah, Li-ion battery 451715-001

6-cell, 55-Ah, Li-ion battery 451714-001

3-cell, 28-Ah, Li-ion battery 451713-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM
NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Bluetooth module

Description Spare part number

Bluetooth (includes Bluetooth module cable) 451721-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the Bluetooth® module:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.0×5.0 captive screw (1) that secures the Bluetooth module
compartment cover to the computer.

3. Tilt the cover (2) forward to disengage if from the base enclosure.

4. Swing the cover (3) up and back to remove it from the base enclosure. The Bluetooth module
compartment cover is included in the Plastics Kit, spare part number 451743-001.
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5. Disconnect the Bluetooth module cable from the system board (1) and from the Bluetooth
module (2).

6. Remove the Phillips PM2.0×5.0 screw (1) that secures the Bluetooth module to the Bluetooth
module compartment cover.

7. Remove the Bluetooth module (2) from the cover.

Reverse this procedure to reassemble and install the Bluetooth module.
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Memory module

Description Spare part number

2048-MB (667-MHz, PC2-5300, 1-DIMM) 451739-001

1024-MB (667-MHz, PC2-5300, 1-DIMM) 451738-001

512-MB (667-MHz, PC2-5300, 1-DIMM) 451740-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the memory module:

1. Position the computer with the rear panel toward you.

2. Loosen the two Phillips PM2.0×5.0 captive screws (1) that secure the memory module/WLAN
module compartment cover to the computer.

3. Lift the rear edge of the cover (2), swing it up and forward, and remove the cover. The memory
module/WLAN module compartment cover is included in the Plastics Kit, spare part number
451743-001.

4. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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5. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module slot.

Reverse this procedure to install the memory module.
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RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all
passwords and CMOS settings to be cleared.

Description Spare part number

RTC battery 451716-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the memory module (see Memory module on page 45).

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Release the RTC battery (2) from the clip built into the base enclosure by sliding it forward.

3. Remove the RTC battery (3).

Reverse this procedure to install the RTC battery.
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WLAN module
CAUTION: The WLAN module and the WWAN module are not interchangeable.

Description Spare part number

802.11a/b/g/n Broadcom WLAN modules:

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the
United States

441530-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belgium, Belize, Benin, Bermuda, Bolivia, Bosnia & Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape
Verde, the Cayman Islands, the Central African Republic, Chad, Chile, Colombia, Comoros,
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory Coast,
Jamaica, Jordan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lesotho, Liberia, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, the Maldives, Mali, Malta, the
Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea,
Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portugal, Puerto
Rico, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
& Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, Spain, Sri
Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441530-002

● For use in Japan 441530-291

802.11a/b/g/n Intel WLAN modules:

● For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic,
Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia,
Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United
States, Venezuela, and Vietnam

441086-001

● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar,
Romania, Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa,
Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and
Uzbekistan

441086-002

● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

441086-003

● For use in Japan 441086-291

802.11a/b/g Broadcom WLAN modules:

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the
United States

441075-001
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Description Spare part number

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial
Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel,
Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos,
Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea,
Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portugal, the
Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe,
Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri
Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and
Zimbabwe

441075-002

● For use in Japan 441075-291

802.11a/b/g Intel WLAN modules:

● For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic,
Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia,
Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States,
Uruguay, Venezuela, and Vietnam

441082-001

● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar,
Romania, Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa,
Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and
Uzbekistan

441082-002

● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

441082-003

● For use in Japan 441082-291

802.11b/g Broadcom WLAN modules:

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the
United States

441090-001
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Description Spare part number

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial
Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia,
Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea,
Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome &
Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad &
Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates,
the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

441090-002

● For use in Japan 441090-291

802.11b/g Intel WLAN module for use in Thailand 448675-004

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the memory module/WLAN module compartment cover (see Memory module
on page 45).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) and (2) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled (1) is connected to the WLAN module “Main”
terminal. The WLAN antenna cable labeled (2) is connected to the WLAN module “Aux” terminal.
To easily identify the correct cable locations, matching numbers are displayed on the modules
next to the antenna connectors.
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2. Remove the two Phillips PM2.0×3.0 screws (3) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

3. Remove the WLAN module (1) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (2) to prevent incorrect installation.

Reverse this procedure to install the WLAN module.
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Hard drive

Description Spare part number

100-GB, 4200-rpm hard drive 453504-001

80-GB, 4200-rpm hard drive 451730-001

60-GB, 4200-rpm hard drive 451729-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the hard drive:

1. Loosen the two Phillips PM2.0×5.0 captive screws (1) that secure the hard drive cover to the
computer.

2. Lift the front edge of the hard drive cover (2), swing it up and back, and remove the cover. The
hard drive cover is included in the Plastics Kit, spare part number 451743-001.

3. Loosen the two Phillips PM2.0×5.0 captive screws (1) that secure the hard drive bracket to the
computer.
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4. Remove the hard drive bracket (2).

5. Loosen the two Phillips PM2.0×5.0 captive screws (1) that secure the hard drive connector to
the system board.

6. Disconnect the hard drive connector (2) from the system board.

7. Lift the hard drive (3) straight up to remove it from the hard drive.

Reverse this procedure to install the hard drive.
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WWAN module
CAUTION: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number

Verizon EVDO-A WWAN module 451131-001

Cingular HSPDA WWAN module 448673-002

Vodafone HSPDA WWAN module 448672-002

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the SIM (see SIM on page 42).

Remove the WWAN module:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.0×5.0 captive screw (1) that secures the WWAN module compartment
cover to the computer.

3. Lift the left side of the WWAN module compartment cover (2), swing it up and to the right, and
remove the cover. The WWAN module compartment cover is included in the Plastics Kit, spare
part number 451743-001.

4. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.
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5. Remove the two Phillips PM2.5×4.0 screws (2) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

6. Remove the WWAN module (1) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (2) to prevent incorrect installation.

Reverse this procedure to install the WWAN module.
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Optical drive

Description Spare part number

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 451727-001

DVD/CD-RW Combo Drive 451725-001

DVD-ROM Drive 451726-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the optical drive:

1. Position the computer with the right side toward you.

2. Remove the Torx T8M2.5×7.0 screw (1) that secures the optical drive to the computer.

3. If present, remove the Torx T8M2.5×4.0 security screw (2) that secures the optical drive to the
computer.

4. Insert a thin tool, such as a paper clip (3), into the disc tray release access. (The optical drive
disc tray is partially ejected from the optical drive.)

5. Use the disc tray frame to slide the optical drive (4) out of the computer.

6. If it is necessary to replace the optical drive bracket, position the optical drive with the optical
drive bracket toward you.
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7. Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the optical
drive.

8. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.

Switch cover

Description Spare part number

Switch cover (includes LED board and cable) 451717-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the switch cover:

1. Turn the computer right-side up, with the front toward you.

2. Open the computer as far as possible.
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3. Release the switch cover by lifting and swinging the hinge cover sections up and forward until
the switch cover rests upside down on the keyboard.

4. Release the zero insertion force (ZIF) connector (1) to which the LED board cable is attached,
and disconnect the LED board cable (2) from the connector.

5. Remove the switch cover.

Reverse this procedure to install the switch cover.
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Keyboard

For use in: Spare part number For use in: Spare part number

Belgium

Brazil

The Czech Republic

Denmark

France

French Canada

Germany

Greece

Hungary

Iceland

Israel

Italy

Japan

South Korea

Latin America

451748-A41

451748-201

451748-221

451748-081

451748-051

451748-121

451748-041

451748-151

451748-211

451748-DD1

451748-BB1

451748-061

451748-291

451748-AD1

451748-161

The Netherlands and Europe

Norway

Portugal

Russia

Saudi Arabia

Slovakia

Slovenia

Spain

Sweden and Finland

Switzerland

Taiwan

Thailand

Turkey

The United Kingdom

The United States

451748-021

451748-091

451748-131

451748-251

451748-171

451748-231

451748-BA1

451748-071

451748-B71

451748-111

451748-AB1

451748-281

451748-141

451748-031

451748-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the switch cover (see Switch cover on page 57).

Remove the keyboard:

1. Turn the computer upside down, with the front toward you.
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2. Remove the six Torx T8M2.5×7.0 screws that secure the keyboard to the computer.

3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Lift the rear edge of the keyboard (1) and slide it back until the keyboard cable (2) and pointing
stick cable (3) are accessible.

6. Release the ZIF connector (1) to which the keyboard cable is attached, and disconnect the
keyboard cable (2) from the system board.
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7. Release the ZIF connector (3) to which the pointing stick cable is attached, and disconnect the
pointing stick cable (4) from the system board.

8. Remove the keyboard.

9. If it is necessary to replace the LED board cable, turn the keyboard upside down, with the
bottom of the keyboard toward you.

10. If it is necessary to replace the LED board cable, disconnect the cable (1) from the low insertion
force (LIF) connector (2) to which it is attached, and remove the LED board cable (3). The LED
board cable is included in the Cable Kit, spare part number 451722-001.

Reverse this procedure to install the keyboard.
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Display assembly

Description Spare part number

12.1-inch, WXGA display assembly with AntiGlare (includes wireless antenna transceivers and
cables and microphone and cable)

451741-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 48) and the WWAN module (see WWAN module on page 54).

6. Remove the following components:

a. Switch cover (see Switch cover on page 57)

b. Keyboard (see Keyboard on page 59)

Remove the display assembly:

1. Position the computer with the rear panel toward you and the display in an upright position.

2. Remove the two Torx T8M2.5×7.0 screws that secure the display assembly to the computer.

3. Position the computer with the front toward you.

4. Remove the WWAN antenna cables (1) from the routing channel and clips built into the top
cover.

5. Disconnect the display panel cable (2) from the system board.
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6. Remove the WLAN antenna cables (3) from the routing channel and clips built into the top cover.

7. Disconnect the microphone cable (4) from the microphone pass-through cable.

8. Disconnect the display lid switch module cable (1) from the system board.

9. Remove the two Torx T8M2.5×7.0 screws (2) that secure the display assembly to the computer.

10. Lift the display assembly straight up and remove it (3).

11. If it is necessary to replace the display lid switch module, remove the Phillips PM1.5×3.0 screw
(1) that secures the module to the display assembly left hinge.

12. Rotate the module (2) ¼-turn counterclockwise.
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13. Remove the display lid switch module (3). The display lid switch module is available using spare
part number 451724-001.

14. If it is necessary to replace the display bezel or any of the display assembly internal
components, remove the five rubber screw covers (1) and the five Torx T7M2.0×5.0 screws (2)
that secure the display bezel to the display assembly.

15. Flex the inside edges of the left and right sides (1) and the top and bottom sides (2) of the
display bezel until the bezel disengages from the display enclosure.
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16. Remove the display bezel (3). The display bezel is available using spare part number
451733-001.

17. If it is necessary to replace the display hinges, remove the four Torx T7M2.0×5.0 screws (1) that
secure the display panel to the display enclosure.

18. Remove the display panel (2).

19. Remove the two Phillips PM2.0×4.0 screws (1) that secure each display hinge to the display
panel.
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20. Remove the display hinges (2). The left and right display hinges are available using spare part
number 451734-001.

Reverse this procedure to reassemble and install the display assembly.
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Top cover

Description Spare part number

Top cover (includes TouchPad, TouchPad cable, and fingerprint reader board)

NOTE: The fingerprint reader board cable is included in the Cable Kit, spare part number
451722-001.

451723-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the following components:

a. Hard drive (see Hard drive on page 52)

b. Optical drive (see Optical drive on page 56)

c. Switch cover (see Switch cover on page 57)

d. Keyboard (see Keyboard on page 59)

e. Display assembly (see Display assembly on page 62)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.
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2. Remove the following:

(1) Four base enclosure rubber screw covers. The base enclosure rubber screw covers are
included in the Rubber Kit, spare part number 451744-001.

(2) Five Torx T8M2.5×4.0 screws.

(3) Three Torx T8M2.5×7.0 screw.

3. Turn the computer right-side up, with the front toward you.

4. Remove the three Torx T8M2.5×7.0 screws that secure the top cover to the computer.
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5. Lift the rear edge of the top cover and swing it up and forward until the top cover rests upside
down in front of the base enclosure.

6. Release the ZIF connector (1) to which the fingerprint reader board cable is connected and
disconnect the fingerprint reader board cable (2) from the system board.

7. Remove the top cover.

Reverse this procedure to install the top cover.
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System board

Description Spare part number

Equipped with Intel Core Duo U7700 (1.33-GHz) processor (533-MHz FSB and 2-MB L2 cache) 464764-001

Equipped with Intel Core Duo U7600 (1.20-GHz) processor (533-MHz FSB and 2-MB L2 cache) 451720-001

Equipped with Intel Core Duo U7500 (1.06-GHz) processor (533-MHz FSB and 2-MB L2 cache) 451719-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the following components:

a. Hard drive (see Hard drive on page 52)

b. Optical drive (see Optical drive on page 56)

c. Switch cover (see Switch cover on page 57)

d. Keyboard (see Keyboard on page 59)

e. Display assembly (see Display assembly on page 62)

f. Top cover (see Top cover on page 67)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● SIM (see SIM on page 42)

● Memory module (see Memory module on page 45)

● RTC battery (see RTC battery on page 47)

● WLAN module (see WLAN module on page 48)

● WWAN module (see WWAN module on page 54)

● Fan/heat sink assembly (see Fan/heat sink assembly on page 74)

● PC Card assembly (see PC Card assembly on page 76)

● Modem module (see Modem module on page 78)

Remove the system board:

1. Turn the computer upside down, with the rear panel toward you.
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2. Disconnect the fan cable from the system board.

3. Turn the computer right-side up, with the front toward you.

4. Press the PC Card eject button (1) twice. The first press releases the PC Card eject button from
the PC Card slot. The second press releases the PC Card slot bezel from the PC Card slot. (The
PC Card slot bezel is partially ejected from the PC Card slot.) The PC Card slot bezel is included
in the Plastics Kit, spare part number 451743-001.

5. Remove the PC Card slot bezel (2).
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6. Disconnect the front LED board cable (1) and the speaker cable (2) from the system board.

7. Remove the three Torx T8M2.5×7.0 screws (1) and the two Phillips PM2.0×10.0 screws (2) that
secure the system board to the base enclosure.

8. Use the optical drive connector (1) to lift the left side of the system board (2) until it rests at an
angle.

9. Remove the system board (3) by sliding it away from the base enclosure at an angle.
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Reverse the preceding procedure to install the system board.

Speaker assembly

Description Spare part number

Speaker assembly 451747-001

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the following components:

a. Hard drive (see Hard drive on page 52)

b. Optical drive (see Optical drive on page 56)

c. Switch cover (see Switch cover on page 57)

d. Keyboard (see Keyboard on page 59)

e. Display assembly (see Display assembly on page 62)

f. Top cover (see Top cover on page 67)

g. System board (see System board on page 70)

Remove the speaker assembly:

1. Remove the Torx T8M2.5×4.0 screw (1) that secures the speaker assembly to the base
enclosure.
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2. Remove the speaker assembly (2) from the base enclosure.

Reverse this procedure to install the speaker assembly.

Fan/heat sink assembly
NOTE: All fan/heat sink assembly spare part kits include thermal material.

Description Spare part number

Fan/heat sink assembly 451731-001

Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the following components:

a. Hard drive (see Hard drive on page 52)

b. Optical drive (see Optical drive on page 56)

c. Switch cover (see Switch cover on page 57)

d. Keyboard (see Keyboard on page 59)

e. Display assembly (see Display assembly on page 62)

f. Top cover (see Top cover on page 67)

g. System board (see System board on page 70)
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Remove the fan/heat sink assembly:

1. Remove the two Torx T8M2.5×4.0 screws (1) that secure the fan/heat sink assembly to the base
enclosure.

2. Remove the fan/heat sink assembly (2) from the base enclosure.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1) and
(3), the processor (2), and graphics system component (4) each time the heat sink is removed.
Thermal material is included with all heat sink and processor spare part kits.

Reverse this procedure to install the fan/heat sink assembly.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left and
right sides of the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is
displaced through the ventilation grill located on the left side of the computer.
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PC Card assembly

Description Spare part number

PC Card assembly 451742-001

Before removing the PC Card assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the following components:

a. Hard drive (see Hard drive on page 52)

b. Optical drive (see Optical drive on page 56)

c. Switch cover (see Switch cover on page 57)

d. Keyboard (see Keyboard on page 59)

e. Display assembly (see Display assembly on page 62)

f. Top cover (see Top cover on page 67)

g. System board (see System board on page 70)

Remove the PC Card assembly:

1. Turn the system board upside down, with the front toward you.

2. Detach the slots on the PC Card assembly (1) from the tabs on the PC Card connector (2).

3. Remove the PC Card assembly (3).
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Reverse this procedure to install the PC Card assembly.
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Modem module
NOTE: All modem module spare part kits include a modem module cable.

Description Spare part number

For use in all countries and regions except Australia and New Zealand 443899-001

For use only in Australia and New Zealand 443899-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the following components:

a. Hard drive (see Hard drive on page 52)

b. Optical drive (see Optical drive on page 56)

c. Switch cover (see Switch cover on page 57)

d. Keyboard (see Keyboard on page 59)

e. Display assembly (see Display assembly on page 62)

f. Top cover (see Top cover on page 67)

g. System board (see System board on page 70)

Remove the modem module:

1. Turn the system board upside down, with the front toward you.

2. Remove the two Phillips PM2.5×4.0 screws (1) that secure the modem module to the system
board.

3. Disconnect the modem module (2) from the system board by lifting it straight up.
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4. Disconnect the modem module cable (3) from the system board.

Reverse this procedure to install the modem module.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to
navigate and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer.

2. Before Windows® opens and while the "F10 = ROM Based Setup" message is displayed in the
lower-left corner of the screen, press f10.
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Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation
and selection are by keystroke:

● To choose a menu or a menu item, use the arrow keys.

● To select an item, press enter.

● To close open dialog boxes and return to the main Computer Setup screen, press esc.

● To view navigation information, press f1.

● To change the language, press f2.

2. Select the File, Security, Diagnostics, or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

● To exit Computer Setup without saving your preferences, use the arrow keys to select File
> Ignore Changes and Exit. Then follow the instructions on the screen.

● To save your preferences and exit Computer Setup, use the arrow keys to select File >
Save Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore defaults, and then press enter.

3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System information ● View identification information for the computer and the batteries in the
system.

● View specification information for the processor, cache and memory size,
system ROM, video revision, and keyboard controller version.

Restore defaults Replace the configuration settings in Computer Setup with the original factory
settings. (Password settings and security settings are not changed when you
restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and restart
the computer.

Save changes and exit Save any changes entered during the current session. Then exit and restart the
computer. Your changes go into effect when the computer restarts.
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Security menu

Select To do this

Setup password Enter, change, or delete a setup password.

Power-On password Enter, change, or delete a power-on password.

Password options ● Enable/disable stringent security.

● Enable/disable password requirement on computer restart.

DriveLock passwords ● Enable/disable DriveLock on any computer hard drive and on optional
MultiBay hard drives.

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you enter Computer
Setup by turning on (not restarting) the computer.

Smart Card security Enable/disable support for smart card and Java™ Card power-on
authentication.

NOTE: Power-on authentication for smart cards is supported only on
computers with optional smart card readers.

NOTE: You must have an administrator password to change this setting.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM) Embedded Security,
which protects the computer from unauthorized access to owner functions
available in Embedded Security for ProtectTools. For more information, refer to
the ProtectTools software Help.

NOTE: You must have a setup password to change this setting.

System IDs Enter user-defined computer asset tracking number and ownership tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary hard drive. The
following options are available:

● Fast: Runs the Disk Sanitizer erase cycle once.

● Optimum: Runs the Disk Sanitizer erase cycle 3 times.

● Custom: Allows you to select the desired number of Disk Sanitizer erase
cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary hard drive is
destroyed permanently.

Diagnostics menu

Select To do this

Hard Drive Self-Test options Run a comprehensive self-test on any hard drive in the system or on any
optional MultiBay hard drive.

Memory Check Run a comprehensive check on system memory.

Startup Check (select models only) Verify the system components needed for starting the computer.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language (or press f2) Change the Computer Setup language.

Boot options ● Set f9, f10, and f12 delay when starting up.

● Enable/disable CD-ROM boot.

● Enable/disable floppy boot.

● Enable/disable internal network adapter boot and set the boot mode (PXE
or RPL).

● Enable/disable MultiBoot, which sets a boot order that can include most
boot devices in the system.

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device configurations ● Swap the functions of the fn key and left ctrl key.

● Enable/disable multiple standard pointing devices at startup. (To set the
computer to support only a single, usually nonstandard, pointing device at
startup, select Disable.)

● Enable/disable USB legacy support. When enabled, USB legacy support
allows the following:

◦ Use of a USB keyboard, mouse, and hub in Computer Setup even
when a Windows operating system is not running.

◦ Startup from bootable USB devices, including a hard drive, diskette
drive, or optical drive connected by a USB port to the computer or to
an optional docking device (select models only).

● Select a parallel port mode: EPP (Enhanced Parallel Port), standard,
bidirectional, or ECP (Enhanced Capabilities Port).

● Enable/disable BIOS DMA data transfers.

● Enable/disable fan always on while connected to an AC outlet.

● Enable/disable Intel® Data Execution Prevention or AMD® PSAE
Execution Disable. When enabled, the processor can disable some virus
code execution, which helps to improve computer security.

● Enable/disable LAN Power Save. When enabled, saves power by turning
off the LAN when not in use.

● Enable/disable SATA Native Mode.

● Enable/disable Dual Core CPU.

● Enable/disable Secondary Battery Fast Charge.

● Choose Bit-shift or LBA assisted HDD Translation Mode.

● Enable/disable Windows direct application launcher.

● Enable/disable HP Lockout.
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Select To do this

Built-In Device Options ● Enable/disable embedded WWAN Device Radio.

● Enable/disable embedded WLAN Device Radio.

● Enable/disable embedded Bluetooth® Device Radio.

● Enable/disable LAN/WLAN Switching. When enabled, switches to a WLAN
when a LAN is either unavailable or disconnected.

● Enable/disable Wake on LAN from Off.

● Enable/disable the ambient light sensor.

Port Options ● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables MultiBay devices and
ExpressCard devices on the advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the cardbus slot.

● Enable/disable the ExpressCard slot.

● Enable/disable the infrared port.

● Enable/disable the optical disk drive.

● Enable/disable the network controller.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Depth 21.29 cm 8.38 in

Width 28.22 cm 11.11 in

Height (front to rear) 2.46 to 3.20 cm 0.97 to 1.26 in

Weight (varies by configuration)

Equipped with optical drive, 9-cell battery, and WLAN
module

1.77 kg 3.9 lbs

Equipped with optical drive, 6-cell battery, and WLAN
module

1.63 3.6 lbs

Equipped with optical drive, 3-cell battery, and WLAN
module

1.45 3.2 lbs

Equipped with 3-cell battery and WLAN module 1.27 2.8 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 90 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock
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 Metric U.S.

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.

12.1-inch, WXGA display specifications
 Metric U.S.

Dimensions

Height 16.9 cm 6.7 in

Width 26.2 cm 10.3 in

Diagonal 30.8 cm 12.1 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1280 × 800

Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-40 horizontal, +120/–40° vertical (typical)
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Hard drive specifications
 100-GB* 80-GB* 60-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g

Interface type SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms

Logical blocks 195,350,400 156,280,320 117,210,240

Disc rotational speed 4200 rpm 4200 rpm 4200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW and CD-RW Double-Layer Combo Drive
specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD),
Multisession CD (Photo-CD, CD-EXTRA,
Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-
R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-
RW, DVD-RAM

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 175 ms < 230 ms

Full stroke < 285 ms < 335 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode

Startup time < 15 seconds

Stop time < 6 seconds
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DVD/CD-RW Combo Drive specifications
Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD),
Multisession CD (Photo-CD, CD-EXTRA,
Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-
R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 110 ms < 130 ms

Full stroke < 210 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate  

24X CD-ROM 3,600 KB/sec

8X DVD 3,600 KB/sec

24X CD-R 3,600 KB/sec

24X CD-RW 3,600 KB/sec

Transfer mode Multiword DMA mode 2

Startup time < 15 seconds

Stop time < 6 seconds
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DVD-ROM Drive
Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital

Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc

Mini disc

12 cm (4.72 in)

8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 100 ms < 125 ms

Full stroke < 175 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 512 KB

Data transfer rate

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2 16.6 MB/s

Startup time < 10 seconds

Stop time < 3 seconds
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System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
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System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial
port may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)

202 - 21F Unused
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I/O address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)
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System memory map specifications
Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in
the computer. All screws listed in this section are available in the Screw Kit, spare part number
451745-001, and the Display Screw Kit, spare part number 451737-001.
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Phillips PM2.0×5.0 captive screw

Color Quantity Length Thread Head diameter

Black 8 5.0 mm 2.0 mm 4.5 mm

Where used:

(1) One screw that secures the Bluetooth module compartment cover to the computer (screw is
captured on the cover by a C-clip)

(2) Two screws that secure the memory module/WLAN module compartment cover to the computer
(screws are captured on the cover by C-clips)

(3) Two screws that secure the hard drive cover to the computer (screws are captured on the cover
by C-clips)

(4) One screw that secures the WWAN module compartment cover to the computer (screw is
captured on the cover by a C-clip)
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Where used: 2 captive screws that secure the hard drive bracket to the computer (screws are
captured on the bracket by C-clips)
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Phillips PM2.0×5.0 screw

Color Quantity Length Thread Head diameter

Black 1 5.0 mm 2.0 mm 4.5 mm

Where used: One screw that secures the Bluetooth module to the Bluetooth module compartment
cover
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Phillips PM2.5×4.0 screw

Color Quantity Length Thread Head diameter

Black 6 4.0 mm 2.5 mm 5.0 mm

Where used:

(1) Two screws that secure the WLAN module to the system board

(2) Two screws that secure the WWAN module to the system board
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Where used: 2 screws that secure the modem module to the system board
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Torx T8M2.5×7.0 screw

Color Quantity Length Thread Head diameter

Black 20 7.0 mm 2.5 mm 5.0 mm

Where used:

(1) One screw that secures the optical drive to the computer

(2) Six screws that secure the keyboard to the computer

Where used: 2 screws that secure the display assembly to the computer
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Where used: 2 screws that secure the display assembly to the computer

Where used: 3 screws that secure the top cover to the base enclosure

Where used: 3 screws that secure the top cover to the base enclosure
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Where used: 3 screws that secure the system board to the base enclosure
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Torx T8M2.5×4.0 screw

Color Quantity Length Thread Head diameter

Black 9 4.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the optical drive to the computer

Where used: 5 screws that secure the top cover to the base enclosure
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Where used:

(1) One screw that secures the speaker to the base enclosure

(2) Two screws that secure the fan/heat sink assembly to the base enclosure
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Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Silver 2 3.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the optical drive bracket to the optical drive
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Phillips PM1.5×3.0 screw

Color Quantity Length Thread Head diameter

Silver 1 3.0 mm 1.5 mm 4.0 mm

Where used: One screw that secures the display lid switch module to the display assembly
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Torx T6M2.0×5.0 screw

Color Quantity Length Thread Head diameter

Black 9 5.0 mm 2.0 mm 4.5 mm

Where used: 5 screws that secure the display bezel to the display enclosure

Where used: 4 screws that secure the display panel to the display enclosure
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Phillips PM2.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver 4 4.0 mm 2.0 mm 4.5 mm

Where used: 4 screws that secure the display hinges to the display panel
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Phillips PM2.0×2.0 broad-head screw

Color Quantity Length Thread Heat width

Silver 2 7.0 mm 2.5 mm 7.0 mm

Where used: 2 screws that secure the fingerprint reader board to the top cover
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Phillips PM2.0×10.0 screw

Color Quantity Length Thread Head diameter

Black 2 10.0 mm 2.0mm 4.5 mm

Where used: 2 screws that secure the system board to the base enclosure
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8 Backup and recovery

Backup and recovery using Windows Vista
Creating recovery discs

After setting up the computer for the first time, be sure to create a set of recovery discs of the full
factory image. The recovery discs are used to start up (boot) the computer and recover the operating
system and software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● Use any of the following types of discs: CD-R, DVD+R, DVD+R DL, DVD-R, or DVD-R DL
(purchased separately). The discs you use will depend on the type of optical drive installed in
your computer. Because DVDs store more information than CDs, DVDs and DVDs with double-
layer (DL) support reduce the number of discs required.

NOTE: Read-write discs, such as CD-RW, DVD+RW, and DVD-RW, are not compatible with
the HP Backup & Recovery Manager software.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery
discs. The next time you select Create a set of recovery discs (Recommended), you will be
prompted to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2. Click Next.

3. Click Create a set of recovery discs (Recommended), and then click Next.

4. Follow the on-screen instructions.

Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you
use HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your
computer.
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With HP Backup & Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your
computer by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events

When to back up

● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions
● Create a set of recovery discs using HP Backup & Recovery Manager.

● Create system recovery points using HP Backup & Recovery Manager, and periodically copy
them to disc.

● Store personal files in the Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected
to external power.

NOTE: Drivers, utilities, and software installed by HP can be copied to a CD or to a DVD using HP
Backup & Recovery Manager.

Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional
external hard drive, or to optical discs (CDs or DVDs).
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NOTE: This process will take several minutes, depending on the file size and the speed of the
computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Back up user created files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image,
including the Windows® operating system, software, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network
drive, or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Entire Drive Backups, and then click Next.

5. Follow the on-screen instructions.
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Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points.
This allows you to save a snapshot of your hard drive at a specific point in time. You can then recover
back to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the
first time you perform a backup. Subsequent recovery points make copies of changes made after that
time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since
that recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for
specific files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly,
or monthly) or at specific events, such as at system restart or when you dock to an optional docking
station (select models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.

Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you
use HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your
computer.

HP Backup & Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a
full system recovery.

● Performing a full system recovery—With HP Backup & Recovery Manager, you can recover your
full factory image if you experience system failure or instability. HP Backup & Recovery Manager
works from a dedicated recovery partition on the hard drive or from recovery discs you create.
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Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows

To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

3. Click Next.

4. Click Perform a recovery, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition

To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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Backup and recovery using Windows XP
Creating recovery discs

After setting up the computer for the first time, be sure to create a set of recovery discs of the full
factory image. The recovery discs are used to start up (boot) the computer and recover the operating
system and software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● Use any of the following types of discs: CD-R, DVD+R, DVD+R DL, DVD-R, or DVD-R DL
(purchased separately). The discs you use will depend on the type of optical drive installed in
your computer. Because DVDs store more information than CDs, DVDs and DVDs with double-
layer (DL) support reduce the number of discs required.

NOTE: Read-write discs, such as CD-RW, DVD+RW, and DVD-RW, are not compatible with
the HP Backup and Recovery Manager software.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery
discs. The next time you select Create factory software recovery CDs or DVDs to recover
the system (Highly recommended), you will be prompted to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Create factory software recovery CDs or DVDs to recover the system (Highly
recommended), and then click Next.

4. Follow the on-screen instructions.

Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you
use HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your
computer.

With HP Backup and Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your
computer by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events
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When to back up

● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions

● Create a set of recovery discs using HP Backup and Recovery Manager.

● Create system recovery points using HP Backup and Recovery Manager, and periodically copy
them to disc.

● Store personal files in the My Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected
to external power.

NOTE: Drivers, utilities, and software installed by HP can be copied to a CD or to a DVD using HP
Backup and Recovery Manager.

Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional
external hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the
computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click Next.
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4. Click Back up individual files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image,
including the Windows® operating system, software, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network
drive, or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click Next.

4. Click Back up entire hard drive, and then click Next.

5. Follow the on-screen instructions.
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Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points.
This allows you to save a snapshot of your hard drive at a specific point in time. You can then recover
back to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the
first time you perform a backup. Subsequent recovery points make copies of changes made after that
time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since
that recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for
specific files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly,
or monthly) or at specific events, such as at system restart or when you dock to an optional docking
station (select models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.

Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you
use HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your
computer.

HP Backup and Recovery Manager helps you with the following tasks for safeguarding your
information and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a
full system recovery.

● Performing a full system recovery—With HP Backup and Recovery Manager, you can recover
your full factory image if you experience system failure or instability. HP Backup and Recovery
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Manager works from a dedicated recovery partition on the hard drive or from recovery discs you
create.

Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows

To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

3. Click Next.

4. Click Recover important files or the entire system, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition

To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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9 Connector pin assignments

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

Korea EK 4

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. Careful handling must be exercised when removing these components. When you remove
these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Symbols/Numerics
1394a port 14

A
AC adapter, spare part

number 27, 29
ambient light sensor 5
antennae, disconnecting 50, 54
audio, product description 2
audio-in jack

location 14, 15
pin assignments 126

audio-out jack
location 14, 15
pin assignments 126

B
backing up 114, 120
backup

files and folders 115, 121
hard drive 116, 122
modifications made to the

system 117, 123
scheduling 117, 123

base enclosure, spare part
number 21, 31

battery
location 16
removal 41
spare part numbers 21, 31, 41

battery bay 16
battery latches 16
battery light 8, 11
Bluetooth module

location 11
removal 43
spare part number 24, 31, 43

Bluetooth module cable 26
Bluetooth module

compartment 17

Bluetooth module compartment
cover

illustrated 25
removal 43

boot options 84
boot order 84
bottom components 16
business-card holder 17
buttons

info 6
power 6
presentation 6
TouchPad on/off 7
volume mute 7
wireless 6

C
Cable Kit

contents 26
spare part number 24, 26, 31

cables, service considerations 35
capacity board cable 26
caps lock light 8
carrying case, spare part

number 28
chipset, product description 1
CMOS clearing 39
components

bottom 16
buttons 6
display 5
fingerprint reader 6
front 11
keys 7
left-side 12
lights 8
pointing devices 10
rear 13
right-side 14
top 6

computer feet
locations 40
spare part number 21, 32, 40

Computer Setup
accessing 80
Diagnostics menu 83
File menu 82
navigating and selecting 81
restoring factory settings 81
Security menu 83
System Configuration

menu 84
using 81

computer specifications 86
connectors

docking 14, 15
service considerations 35

creating recovery points 117, 123

D
Diagnostics menu 83
Disk Sanitizer 83
diskette drive

precautions 35
product description 2
spare part number 28

display assembly
removal 62
spare part number 19, 32, 62

display bezel
removal 64
spare part number 19, 32, 65

display component recycling 132
display components 5
display enclosure, spare part

number 20, 32
display hinge

removal 65
spare part number 20, 32, 66
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display lid switch module
removal 63
spare part number 20, 32

display panel cable, spare part
number 19, 32

display panel, removal 65
display release latch 5, 11
Display Screw Kit, spare part

number 20, 32
display specifications 87
display switch 5
docking connector 14, 15
docking station, spare part

numbers 27, 29, 33
docking support, product

description 3
drive light 8, 11
DriveLock password 83
drives

boot order 84
preventing damage 35

DVD-ROM Drive
precautions 35
removal 56
spare part

numbers 21, 27, 32, 56
specifications 91

DVD/CD-RW Combo Drive
precautions 35
removal 56
spare part

number 21, 27, 32, 56
specifications 90

DVD±RW and CD-RW Combo
Drive

precautions 35
removal 56
spare part

number 21, 27, 32, 56
specifications 89

E
electrostatic discharge 36
esc key 7
Ethernet, product description 2
Execution Disable 84
external media cards, product

description 3

external monitor port
location 14, 15
pin assignments 127

External MultiBay II power cable
and stand, spare part
number 27

External MultiBay II, spare part
number 27

F
fan/heat sink assembly

removal 74
spare part number 21, 32, 74

feet
locations 40
spare part number 21, 32, 40

File menu 82
fingerprint reader board cable 26
fn key 7
front components 11
function keys 7

G
graphics, product description 1
grounding equipment and

methods 38

H
hard drive

location 16
precautions 35
product description 2
removal 52
spare part

numbers 24, 27, 32, 33, 52
specifications 88

hard drive backup 116, 122
hard drive bay 16
hard drive bracket, removal 53
hard drive cover

illustrated 25
removal 52

hard drive recovery 118, 124
hard drive test 83
headphone jack

location 14, 15
pin assignments 126

hinge
removal 65
spare part number 20, 32, 66

HP Extended Life Battery, spare
part number 27

HP Fingerprint Sensor 7

I
I/O address specifications 94
info button 6
interrupt specifications 93

J
jacks

audio-in 14, 15
audio-out 14, 15
headphone 14, 15
microphone 14, 15
modem 12
network 13
RJ-11 12
RJ-45 13

K
keyboard

product description 4
removal 59
spare part numbers 20, 32, 59

keypad keys 7
keys

esc 7
fn 7
function 7
keypad 7
Windows applications 7
Windows logo 7

L
Label Kit, spare part

number 27, 32
LAN Power Save 84
language, changing in Computer

Setup 84
LED cable 26
left-side components 12
legacy support, Universal Serial

Bus (USB) 80, 84
lights

battery 8, 11
caps lock 8
drive 8, 11
num lock 9
power 8, 11
volume down 9
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volume mute 9
volume up 9
wireless 8, 11

M
mass storage devices, spare part

numbers 27
Media Card Reader 14
memory check 83
memory map specifications 96
memory module

product description 1
removal 45
spare part numbers 24, 32, 45

memory module/WLAN module
compartment 16

memory module/WLAN module
compartment cover

illustrated 25
removal 45

microphone 5
microphone jack

location 14, 15
pin assignments 126

modem cable 26
modem jack

location 12
pin assignments 128

modem module
product description 2
removal 78
spare part numbers 21, 31, 78

monitor port
location 14, 15
pin assignments 127

N
navigating in Computer Setup 81
network jack

location 13
pin assignments 128

num lock light 9

O
operating system, product

description 4
optical drive

location 12
precautions 35
product description 2
removal 56

spare part
numbers 21, 27, 32, 56

specifications 89, 90, 91
optical drive light 12

P
packing guidelines 37
panels, product description 1
parallel port mode 84
password clearing 39
passwords 83
PC Card assembly

removal 76
spare part number 21, 32, 76

PC Card slot 14
PC Card slot bezel, illustrated 25
pin assignments

audio-in jack 126
audio-out jack 126
external monitor port 127
headphone jack 126
microphone jack 126
modem jack 128
monitor port 127
network jack 128
RJ-11 128
RJ-45 jack 128
Universal Serial Bus (USB)

port 129
plastic parts 34
Plastics Kit

contents 25
spare part number 21, 25, 32

pointing device components
illustrated 10
pointing stick 10
pointing stick buttons 10
TouchPad 10
TouchPad buttons 10
TouchPad on/off button 10
TouchPad scroll zone 10

pointing devices, product
description 4

pointing stick 10
pointing stick buttons 10
pointing stick cable

removal 61
ports

1394a 14
external monitor port 14, 15

monitor port 14, 15
product description 3
Universal Serial Bus

(USB) 12, 14, 15
power button 6
power connector 12
power cord

set requirements 130
spare part numbers 28, 29

power light 8, 11
power requirements, product

description 4
power-on password 83
presentation button 6
processor, product description 1
product description

audio 2
chipset 1
diskette drive 2
docking support 3
Ethernet 2
external media cards 3
graphics 1
hard drives 2
keyboard 4
memory module 1
modem module 2
operating system 4
optical drives 2
panels 1
pointing devices 4
ports 3
power requirements 4
processors 1
security 4
serviceability 4
wireless 2

R
rear components 13
recovery discs

creating 114, 120
using 118, 124

recovery partition 119, 125
recovery points 117, 123
removal/replacement

preliminaries 34
procedures 40

restoring Computer Setup factory
settings 81
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right-side components 14
RJ-11 jack

location 12
pin assignments 128

RJ-45 jack
location 13
pin assignments 128

RTC battery
removal 47
spare part number 24, 31, 47

Rubber Kit, spare part
number 21, 32

S
scheduling backups 117, 123
Screw Kit

contents 97
spare part number 28, 32

screw listing 97
security cable slot 13
Security menu 83
security, product description 4
selecting in Computer Setup 81
serial number 18, 40
service considerations 34
serviceability, product

description 4
SIM slot 16
SIM, removal 42
smart card reader module, spare

part number 24, 32
smart card security 83
speaker 16
speaker assembly

removal 73
spare part number 21, 32, 73

specifications
computer 86
display 87
DVD-ROM Drive 91
DVD/CD-RW Combo Drive 90
DVD±RW and CD-RW Combo

Drive 89
hard drive 88
I/O addresses 94
interrupts 93
memory map 96
optical drive 89, 90, 91
system DMA 92

startup check 83

static-shielding materials 38
stringent security 83
switch cover

removal 57
spare part number 20, 31, 57

system backup 116, 122
system board

removal 70
spare part

numbers 21, 31, 33, 70
System Configuration menu 84
system DMA 92
system fan 84
system information 82
system memory map 96
system recovery points 117, 123

T
thermal material, replacement 75
tools required 34
top components 6
top cover

removal 67
spare part number 21, 31, 67

TouchPad 10
TouchPad buttons 10
TouchPad on/off button 7, 10
TouchPad scroll zone 10
transporting guidelines 37

U
Universal Serial Bus (USB) legacy

support 84
Universal Serial Bus (USB) port

location 14, 15
pin assignments 129

unknown password 39
USB legacy support 80

V
vents 12, 14, 15, 16
volume down light 9
volume mute button 7
volume mute light 9
volume scroll zone 7
volume up light 9

W
Windows applications key 7
Windows logo key 7

wireless antennae,
disconnecting 50, 54

wireless button 6
wireless light 8, 11
wireless, product description 2
WLAN module

removal 48
spare part numbers 21, 29, 48

workstation guidelines 37
WWAN module

removal 54
spare part numbers 24, 31, 54

WWAN module compartment 17
WWAN module compartment

cover
illustrated 25
removal 54
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